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Course Code : CS-612 
Course Title : PC Software and Application Skills 
There are four questions in this assignment. Answer all the questions. You may use 
illustrations and diagrams to enhance explanations. 

Question 1: 
(a) What is a worksheet? How to create and format controls on worksheet. 
Hint: A worksheet is a single page or sheet in an Excel spreadsheet. By default, there are three 
worksheets per file. Switching between worksheets is done by clicking on the sheet tab at the bottom 
of the screen. To create a professional looking appearance for a worksheet form, you should provide 
a consistent format to all controls and objects, and size them appropriately. You can resize a control 
by dragging its sizing handles or by entering measurements in the Format Control dialog box. 
1. If one or more controls is an ActiveX control: 
1. Make sure that the Developer tab is available. Display the Developer tab 

2. Make sure that you are in design mode. On the Developer tab, in the Controls group, turn on 
Design Mode . 
2. Select the control that you want to resize. 

3. Do one of the following: 

Resize by using the sizing handles 
1. Position the pointer over one of the handles. 

2. Do one of the following: 

� To increase or decrease the size in one or more directions, drag the mouse away from or toward 
the center. 

� To keep the center of a control in the same place, hold down CTRL while you drag the mouse. 

� To maintain the control's proportions, hold down SHIFT while you drag the mouse. 

� To maintain the proportions while keeping the center in the same place, hold down CTRL and 
SHIFT while you drag the mouse. 

1. Release the mouse, and then release CTRL or SHIFT. 
Resize by entering measurements 
1. Right-click the selection and then click Format Control.
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2. On the Size tab, enter measurements for the height and width of the control, or click the up or 
down arrow keys to move the height and width. 

3. To maintain the control's proportions, select the Lock aspect ratio check box. 
NOTE The Reset button (which resets the original height and width), the Rotation text box, and the 
Relative to original picture size check box are not available. (b) What is need of a web browser? List 
the advantages and disadvantages of different browsers. Hint: A web browser or Internet browser is 
a software application for retrieving, presenting, and traversing information resources on the World 
Wide Web. An information resource is identified by a uniform resource identifier (URI) and may be 
a web page, image, video, or other piece of content. Hyperlinks present in resources enable users to 
easily navigate their browsers to related resources. Although browsers are primarily intended to 
access the World Wide Web, they can also be used to access information provided by Web servers
in private networks or files in file systems. Some browsers can also be used to save information 
resources to file systems. Mozilla released Firefox 3.0 on 17 June 2008, with performance 
improvements, and other new features. Firefox 3.5 followed on 30 June 2009 with further 
performance improvements, native integration of audio and video, and more privacy features. 
Google released the Chrome browser for Microsoft Windows on December 11, 2008, using the 
same Web Kit rendering engine as Safari and a faster JavaScript engine called V8. An open sourced 
version for the Windows, Mac OS X and Linux platforms was released under the name Chromium. 
According to Net Applications, Chrome had gained a 3.6% usage share by October 2009. After the 
release of the beta for Mac OS X and Linux, the market share had increased rapidly. On March 19, 
2009, Microsoft released Internet Explorer 8, which added accelerators, improved privacy 
protection; a compatibility mode for pages designed for Internet Explorer 7 and improved support
for various web standards. During December 2009 and January 2010, Stat Counter reported that its 
statistics indicated that Firefox 3.5 was the most popular browser, when counting individual 
browser versions, passing Internet Explorer 7 and 8 by a small margin. This is the first time a global 
statistic has reported that a non-Internet Explorer browser version has exceeded the top Internet 
Explorer version in usage share since the fall of Netscape Navigator. This feat, which Geek Smack 
called the "dethrone of Microsoft and its Internet Explorer 7 browser," can largely be attributed to 
the fact that it came at a time when IE 8 was replacing IE 7 as the dominant Internet Explorer 
version. No more than two months later IE 8 had established itself as the most popular browser 
version, a position which it still holds as of March 2011. It should also be noted that other major 
statistics, such as Net Applications, never report any non-IE browser version as having a higher 
usage share than the most popular Internet Explorer version, although Firefox 3.5 was reported as 
the third most popular browser version between December 2009 and February 2010, to be 
replaced by Firefox 3.6 since April 2010, each ahead of IE7 and behind IE6 and IE8. On January 21, 
2010, Mozilla released Mozilla Firefox 3.6, which allows support for a new type of theme display, 
'Personas', which allows users to change Firefox's appearance with a single click. Version 3.6 also 
improves JavaScript performance, overall browser responsiveness and startup times. In October 
2010, Stat Counter reported that Internet Explorer had for the first time dropped below 50% 
market share to 49.87% in their figures. Also, Stat Counter reported Internet Explorer 8's first drop 
in usage share in the same month. On February 3, 2011, Google released Chrome 9. New features 
introduced include: support for WebGL, Chrome Instant, and the Chrome Web Store. Stat Counter 
global market share figures were as follows for February 2011. Internet Explorer 45%, Firefox 30%, 
Chrome 17%, Safari 5% and Opera 2%, leaving all the others sharing the remaining 1%.
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Question 2:
(a) Differentiate between VLOOKUP () AND HLOOKUP () functions in MS_EXCEL

Hint: VLOOKUP ()
Searches for a value in the first column of a table array and returns a value in the same row from 
another column in the table array. The V in VLOOKUP stands for vertical. Use VLOOKUP instead 
of HLOOKUP when your comparison values are located in a column to the left of the data that you 
want to find. SYNTAX OF VLOOKUP 
VLOOKUP(lookup_value,table_array,col_index_num,range_lookup) Where Lookup_value :- The 
value to search in the first column of the table array. Table_Array :- Two or more columns of data. 
Col_index :- The column number in table array from which the matching value must be returned. 
Range_lookup :- A logical value that specifies whether you want VLOOKUP to find a match or an 
approximate match If TRUE or omitted, an exact or approximate match is returned. If an exact match 
is not found, the next largest value that is less than lookup value is returned. HLOOKUP () Searches 
for a value in the top row of a table or an array of values, and then returns a value in the same column 
from a row you specify in the table or array. Use HLOOKUP when your comparison values are 
located in a row across the top of a table of data, and you want to look down a specified number of 
rows. Use VLOOKUP when your comparison values are located in a column to the left of the data 
you want to find. SYNTAX OF HLOOKUP HLOOKUP 
(lookup_value,table_array,row_index_num,range_lookup) Where Lookup_value :- The value to 
search in the first column of the table array. Table_Array :- Two or more columns of data. row_index 
:- The row number in table array from which the matching value must be returned. Range_lookup :-
A logical value that specifies whether you want VLOOKUP to find an exact match or an 
approximate match. If TRUE or omitted, approximate match is returned. If an exact match is not 
found, the next largest value that is less than lookup value is returned. (b) What is FTP? Explain how 
it is different from telnet. Hint: File Transfer Protocol (FTP) is a standard network protocol used to 
copy a file from one host to another over a TCP-based network, such as the Internet. FTP is built on 
client-server architecture and utilizes separate control and data connections between the client and 
server. FTP users may authenticate themselves using a clear-text sign-in protocol but can connect 
anonymously if the server is configured to allow it. The first FTP client applications were interactive 
command-line tools, implementing standard commands and syntax. Graphical user interface clients 
have since been developed for many of the popular desktop operating systems in use today. 
Both of these applications allow two different computers to communicate with each other. Telnet 
allows the user to log on to an account on a remote computer and work as if you were there. This is 
useful if you are traveling or are going to be away from your own computer and your local account 
but need to have access to the latter. You might be at a conference in another state and suddenly 
remember that you need some information that is stored on a file in your account back at your 
home institution. You can log on remotely, telnet to your account, get into your files that are on 
that server, and retrieve the information. For example, let's say you are at ACTFL and you are 
supposed to meet some people but you forgot the time and the place. They sent you this 
information in an e-mail message, and you have that message in your account on the server at your 
institution. If you can use a computer with Internet access where you are, you can telnet to your 
account, call up the message, and read the information off the screen. 
Question 3: 
(a) What is Konigsberg Bridge problem? Explain with a suitable diagram 
Hint: The Konigsberg Bridge Problem is a historical problem in mathematics. The problem was to 
find a route to walk throgh the city of Konigsberg that would cross each bridge ONLY ONCE. You 
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could not walk half way onto a bridge, but had to cross it completely, and islands within the city 
could only be reached by crossing a bridge

Euler's analysis

First, Euler pointed out that the choice of route inside each land mass is irrelevant. The only 
important feature of a route is the sequence of bridges crossed. This allowed him to reformulate the 
problem in abstract terms (laying the foundations of graph theory), eliminating all features except the 
list of land masses and the bridges connecting them. In modern terms, one replaces each land mass 
with an abstract "vertex" or node, and each bridge with an abstract connection, an "edge ", which 
only serves to record which pair of vertices (land masses) is connected by that bridge. The resulting 
mathematical structure is called a graph. 
(b) Prove sum of n terms is n(n+1)/2 by using Gauss trick method . 
Hint: Gauss solved the problem by observing that when the sum is arranged as below: , 1 + 2 + 3 + 4 
+ 5 +... + 96 + 97 + 98 + 99 + 100 and the first term paired with the last: 1 + 100= 101 the second 
with the second from the last: 2 + 99 = 101 the third with the third from the last: 3 + 98 = 101 each 
pair adds to 101. There are fifty such pairs. The sum of numbers from 1 through 100 must therefore 
be 5050! Using Gauss' trick we can write: Sn = 1 + 2 + 3 + ..... + (n - 2) + (n - 1) + n Sn = n + (n - 1) 



Join us on Facebook Page http://www.facebook.com/ignousolution

Join us also on our Group 
http://www.facebook.com/groups/solvedassignment/

+ (n - 2) + ...... + 3 + 2 + 1 2Sn = (n + 1) + (n + 1) + (n + 1) + + (n + 1) = n (n + 1) Thus Sn = n(n + 
1)/2, and Rn = 1 + n ( n + 1) / 2. 
Question 4: 

(a) What is a dialog box? Explain with example how to create dialog boxes in Ms-Excel
(b) Hint: In a graphical user interface of computers, a dialog box (or dialogue box) is a type of 

window used to enable reciprocal communication or "dialog" between a computer and its 
user. It may communicate information to the user, prompt the user for a response, or both. A 
dialog box is most often used to provide the user with the means for specifying how to 
implement a command, or to respond to a question or an "alert" (see below). 

� Open a new Excel worksheet and switch over to the Visual Basic editing tab[ALT+F11]. 
� Make a new function using the "Sub" routine and name it whatever is appropriate to your dialog 
box. Type in the "MsgBox" command to create a new pop up box. 
� Use quotes around the parameters of the message box to write out the message that will be 
displayed. 
� The syntax should be used as MsgBox "This is the message." 
� Use the "Case vbYes" and "Case vbNo" commands to give your dialog box functionality so that 
the user can select multiple options 

(b) Explain with example how to create database in Ms-excel. 
Hint: Well first off, there is one rule we must always follow and that is one excel database per 
worksheet. Anymore and you just get yourself into lots of trouble. In fact if you need to have 
multiple excel databases within your workbook simply put each excel database onto a separate 
worksheet. The next thing you must follow is that your database lists first row must contain the 
heading of the list. That is the first row contains your field names. Plus each of the field names must 
be 100% unique. You cannot have two field names with the same name or again you will have a list 
that will not work. The next issue you need to be concerned with is identifying the field names. 
Excel databases have a simple rule, the field names or column names must be unique. Now the way 
you identify them is easy, all you have to do is to ensure the field names are many different data 
types, format, pattern etc to the rest of the database in your list. Generally what I do is to format 
my field names in bold to satisfy this requirement. One of the most important rules you must 
remember when you create an excel database is that around the row and columns of the fields and 
data there must be a blank row and column. What this means is that you can still have a heading at 
the top of the fields, but there must be a blank row between the heading and the fields as well as 
along the last column as well. The blank row rule also applies to the bottom of the list as well. When 
you are entering data into your list, every cell in every record must contain some value even if it is 
simply blank (a blank value is still considered a value) and each record must contain the same 
number of fields. If there is no specific data for a field you simply leave it blank and move to the 
next field. Ensure that when you are entering data into a field that you don't have spaces before the 
text or at the end of the text in the field. If you do have spaces, then what will happen is that sorting 
and Search for data in the list will be compromised and you will get unexpected results. Upper case 
and low case characters in the field do not affect the searches or sort orders unless you specifically 
tell the Microsoft Excel application it is an issue. You can also use formulas in a cell if required. 
Formulas can refer to cells within the Excel Database List or outside of the Excel Database. Note also 
that you can edit and format the cells just like any other spreadsheet however the issue. You must 
consider as a priority is that the field names must have a different format to the rest of the Data in 
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the database list. It is highly recommended that there be no other formatting in the list Except for 
the field headings. This ensures that there are no miscalculations by the application as to what is a 
field heading in the excel database and what is not. Now that you have setup your list in this way 
following these rules, you are now ready to interrogate the list by applying criteria. The easiest way 
that you can do this is by using the Form dialog box. To get into the Excel Database form you simply 
choose the Data menu and then choose Form from the drop down menu. From the Excel Database 
Form you can simply choose the Criteria button, type the criteria you have for your data and choose 
the Find Next button and it will take you to the first record that satisfies the criteria you are 
searching. Excel Databases are particularly useful for summary data that is where the volume of 
records you have in your database doesn't exceed 65,536 rows.
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